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KernSafe iStorage Server is an advanced and powerful, full-featured software-only iSCSI Target
that fully conforms to the latest iSCSI Standard 1.0 (former Draft 20). It is an IP SAN solution
allowing you to quickly export existing storages such as disk images, VHD files, physical disks,
partitions, CD/DVD-ROMs, tapes or any other type of SCSI based devices and even a variety of
popular CD/DVD images to the client machines. The software thus delivers immediate benefits,
as it allows storage to be consolidated, virtualized and centrally managed. iStorage Server also
provides RAID-1 (mirror) feature enabling you to create two iSCSI devices for mirror backup.
Furthermore, iStorage Server also supports a lot of features such as: VHD (Virtual Hard Disk)
target, snapshots, STPI, RAID-1 and failover, these features are very important and poplar in
storage industry world and make iStorage Server is suitable for any size of business.

After iStorage Server 2.0, it supports server side mirroring, synchronous replication and failover
which allows user to create a high-availability iSCSI SAN.

Internet Protocol Security (IPSec) is an architecture defined by the Internet Engineering Task
Force (IETF) RFC 2401. This architecture involves several protocols that perform various functions
in the architecture.

A network is not secure until servers can identify the computers communicating with them. IPSec
enables secure, trusted communications between IP addresses. The system behind the IP address
has an identity that is verified by using an authentication process. The only computers that must
be aware of IPSec are the sending and receiving computers. Each computer handles security at its
respective end, and assumes that the medium over which the communication takes place is not
secure. Any computers that route data between the source and destination computer are not
required supporting IPSec.

This article demonstrates how to make a Security iSCSI Target under the Windows IP Security
Policies (IP Sec) environment by using KernSafe iStorage Server. Take Windows Server 2003 as an
example, It is also similar to Windows 2000, Windows XP, Windows Vista and Windows Server
2008. At the same time, this article demonstrates how to use the two method of security policy
in the iStorage Server, CHAP and IP Address authentication mechanism and how to configurate
Local Security Policy in the both client and server side.

1. iSCSI Target Setting

A) Create Target
Launch KernSafe iStorage Server Management Console, Select Storage -> Create Target menu
item, the Create Target wizard is shown.



Create iSCSI Target Wizan [

iSC5l Device Type
Select which device type of the i5C51 target pou want to create.

@ Hard Disk
Create iSCS| target by using physical disk, partition, standard image file or VHD.

(7) CDJ/ DVD Device
Create iSCS| target by using physical optical drive or CD / DVD image file.
) Generic SCSI
Create iSCS| tanget by using generic SCS1 device, such as disk, CD-ROM, tape, printer.

Choose Hard Disk.

Press the Next button to continue.

iSCSl Medium Type

Select medium of the ISCSI disk you want to create.

@ Image Rle
Create iSCSI disk by using standard image file or Virtual Hard Disk {(VHD).

Create iSCSI| disk by using memary space.

Create iSCSI disk images for each initistors, any image is individual for each initiator.
(7 Disk Partition

Create iSCSI target by using a disk partition.

) Physical Disk
Create iSCSI tanget by using physical disk.

Choose Image File in iSCSI Medium Type window.



Then press Next button to continue.

iSCSl Image Type

Select image tupe of the ISCSI dizk pou want bo create.

@ Standard Image Fle
Create i5CS5| disk by using a standard disk image file.

) Wirtual Hard Disk (VHD)
Create iSCS| disk by using a Virtual Hard Disk image file.

We choose Standard Image File and then press Next button.

Set image disk parameters

[Crente iSCSI Target Wiz il

Image Disk Configuration
“ou can zpecify a image fle as aniSCS| device.

Device Parameters

(7 Use existing image file i@ Create a new image file

E\newimage img

Device Size in MBs: 1024

Options
[7] Use sparse file on NTFS file system

Mote: Using sparse file can save your harddisk space, the size of disk image file anby
depend on its content used. But we recommentd that using this feature when image
file gize iz legs than 1T bytes

Select Create a new image file or Use existing image file if you already have a one.



Specify the device size.
Press the Next button to continue.

Set Authorization Mode.

Create iSCSI Target Wizan .

Authorization
You can select an authorization mode, Anarymounz, CHAP ar [P filker.

@ Anocnymous
Select this option to disable any authorization.

(") CHAP
Select this option to use CHAP authorization.

) IP Rilter
Select this option to use IP address authorization.
) Mixed
Select this option to use bath CHAP and IP address authorization.

Inhert security roles from global settings.

Choose authorization mode as you required.

Press the Next button to continue.

Finish iSCSI Target Creating.



B reate ISCST Tamen

Completing the Create iSC5I1 Wizard qjj
=

“'ou can zpecify a target name and ather ophions to complete ISC51 target creating.,

Basic Target Information
Enter Target Name:
ign.2006-03 .com kemsafe kemsafetest. ImageDisk0

Report as readonly device when initiator can not get write access
Enable multiple inttiators with full access connected (sharing and clustering)

Mote

By default, onby one client has full access rght. when the second intiaor log on with full
access, it will fail.

But this option is usfull for clustering, disk sharing and NAS.

Type the target name or use the default name.
Press the Finish button to continue.

B) iSCSI Target Setting

This chapter is not necessary for every users of iStorage Server.

Back to iStorage Server Management Console.



Storage  Clients View Tools Help

B . | § &£ Q| @& & | @ . &

Create Delete Start Stop Refresh Add Rermove View Access Settings Print About

Bl kemsale-PC -
B Tagets

:’ :gn.EDDE-DS.com.kernsafe.k [Genera|| Targets hpplicationsulp FiH:ers] Users [Groups] Logs
pplications

@ IPFilters Target Name Devic..  Source Capa.. Authentic.. Status

iStorage Server: kernsafe-PC

Users <= ign.2006-03.com.kernsafe.kem.. Disk.. E\newimageimg 100G Anonyme.. Ena..

@ Connected: kernsafe-PC (Ultimate License)

B1. Modify iSCSI Target authorization method. User may modify iSCSI Target settings by through
this method. Right click on the Target node, and then select the Properties menu item, the
Target Settings dialog is shown.

[ General |D'e'.ri|::e Settingsl_[ﬁecuri‘tyl_[ Portal " Cache]_["u’irtual Wr'rte]

Target Mame:
Capacity:

Media Type:

qn.2006-03 com kemsafe kemsafetest. ImageDisk 0
1.00G

Device Intefface: Disk Drive

Standard Disk Image

To rename the target name: click Change.
To expand the capacity of this target: click Expand.

To commit changes of this target: click Commit.

In General page, you can change the target name and expand the capacity of the target when it is

a standard image file. The commit button is only available for RAM target.



_[General| Device Settings |Securit_',r_[ Portal _[Cache _[‘I.n"irtual Write

Report as readonly device when intistor can not get write access

Enable multiple inttiators with full access connected (sharing and clustering)

In the Device Settings Page, if you check “Report as readonly device when initiator can not get
write access”, the system will give you a report when you load the target without write access.

When your storage server is running in the environment of cluster, the function of concurrent
writing of multi-users is needed and the writing synchronization control is realized by cluster
software. Thus, you need to check “Enable multiple initiators with full access connected”

_[General _[D‘E"-"iCE Settingsl Security |F'orta| _[Cache _[‘I.n"irtual Write

@ Anormymous
Select this option to disable any authorization.

i) CHAP
Select this option to use CHAP authorization.

() IP Fitter
Select this option to use |P address authorization.
() Mixed
Select this option to use both CHAP and IP address authorization.

Inhert securty roles from global settings.




In the Security page, you can change the target’s authorization mechanism.

| Target Settings

_[General_[DeviceSettings_[Securitﬂ Portal |Cache_[‘u"irtua|Write

Inherit from global settings
Target portal address list

-

Portal: 0

|F Address
2 192.168.0.195

£ 192.168.254.1
) 192.162.142.1

Mote, if need to make iStorage Server working behind the firewall, please add the
router IP address to the list.

oK || Cancel

In the Portal page, when you check “Inherit from global settings” the settings will follow the
“Settings” in tool bar, otherwise, you can have your own portal address for this target.

| Target Settings

_[General _[D‘E"-"iCE Settings_[Security_[Portal| Cache PirtuaIWrite

["] Enable cache on this target

Cache Parameters
Cache size in MBs: £4

Cache refresh interval ms: 2000

Cache Granularity: 4K

If you want to speed up the read and wire rate, check Enable cache on this target in the Cache
page.



_[ General " Device Settingsl_[ Securi‘t].r]_[ Portal " Cach e| Virtual Writel

[7] Enable Virtual Write

Wark folder for clients write data:

Data Quota for Vitual Write in MBytes (zem indicate no limitation):
1024 .

Mode
i@ Volatile
Target will reset all changes after intiators log out.

Persistent
Target wil preserve all changes for each intiators with Virual Write access mode.

oK || Cancel Apply

If you want your target has the COW protection, check the “Enable Virtual Write” in the Virtual
Write page.

Once user selected IP filter authorization, he can manage this target’s access right by IP filter.
Click the View->IP Filters on the toolbar or click IP Filters on the left tree of the main interface.

Storage

B . ‘ &

Clients  View Tools Help

&

Stop

8/

Refresh

% .

Remwve

Cl.
= ek
Create Delete Start Add

(=2 kemsafe-PC
BJ Targets
§ i ign 2006-03.com kemsafe k.
08 Applications
@ IFFiters

*" iStorage Server: kernsafe-PC

[Genera|| Targets hpplications"lp Filters" Users "Group'S" Logs ]

Target Name Devic.. Source

“# ign.2006-03.com.kernsafe.kemn... Disk..  E\newimageimg

Capa.. Authentic.. Status

100G Anenymo.. Ena.

Q Connected: kernsafe-PC (Ultimate License)

Click the Add button on the Toolbar, the Add clients to IP filter dialog is shown.



—&dd Tope

@ Ay P Address P Range

— IF or IP Range
BeqinIF:

End IF:

— Access Mode

’Full ACCess

[ 2k ]|Can|::el

Any: Indicate all of the clients connected to the target have the same access right.
IP Address: Indicate the IP address has the given access right.

IP Range: Indicate the clients specified by the range has the given access right.

Press the OK button to add an IP filter item.

Storage  Clients  View Tools Help

@ - ] $ ﬁﬁ @ Iil%f m% = S

Create Stop Refresh Add Remove View Access Settings

) kemsafePC =
=8 em;:[:ets ™ iStorage Server: kernsafe-PC

2 ::’ :F]n.:.?DDB-DS.com.kemsafe.k [General"Targeﬁ]hpplication4 IP Filters | Users] Groups|| Logs
-ail Applications
M@ IFFilters IP Address Computer Name Access Control

3 Users @U.U.U.U Any Address Full Access
m Groups @192.168.0.111 kernsafe-PC Virtual Write
@1192.168.0.102 kernsafe-PC ReadOnly
ﬁ192.168.0.101 kernsafe-PC Refuse

9 Connected: kernsafe-PC (Ultimate License)

User can modify IP filter item’s access right, Read Only, Refuse, Virtual Write and Full Access, or
remove some IP filter items if they are not needed.



2. Server Side Local Security Policy Setting

Click “Start -> Control Panel -> Administrative Tools -> Local Security Policy” open the “Local

Security Settings Management Console.

Ii' Local Security Settings ;lglll

Flle Action  Wiew Help

- Dm R 2B azx

@ Security Settings MName  / | Description | Paolicy ... | Last Modified Time
@ Account Policies Server (Request Sec...  For all IP traffic, abwavs reg... Mo 2009-7-9 14:52:23
B8 Local Palicies lient (Respond Onkyd  Comronicate normally (uns... Mo 2009-7-9 14:52:23

D Fublic Key Policies Secure Server (Requi,.. For all IP traffic, alwavs req... Mo Z003-7-9 14:52:23
CI Software Restriction Policies

----- g IP Security Policies on Local Computer

Create IP 0
Manage IP filter lisks and filter actions, ..

Al Tasks 4
Refresh

Expork List...

= 3
Arrange Icons b

Line up Icons

Help

|Creates an IP Security policy, | |

Select the IP Security Policies on Local Computer, right click on the blank of right panel, then
select the Create IP Security Policy menu item, the IP Security Policy Wizard is shown.



IP Security Policy Wizard ed A

- Welcome to the IP Security Policy
g Wizard
=

Thiz wizard helpz you create an IP Security policy. ou waill
zpecify the level of zecurity bo uze when communicating with
gpecific computers or groups of computers [subnets], and for
particular 1P traffic types.

To continue, click Mest,

< Back

Cancel |

Press the Next button to continue.

Type IP Security Policy Name

IP Security Policy Wizard

IP Security Policy Hame
Mame thiz IF Secunty policy and provide a brief description

M arne:

k.ernSafe [P Secunty Policy

Dezcription:

< Back I Hest » I Cancel

Type “KernSafe IP Security Policy”.



Press the Next button to continue.

Specify how this policy responds to requests for secure communication.

IP Security Policy Wizard ed A

Requests for Secure Communication 7
Specify how thiz policy responds to requests for secure communication.
-

The default rezponze rule responds to remote complters that request security, when no
ather rule applies. To communicate securely, the computer must respond to requests far
FECUNE communication,

[ ctivate the default responze rule. §

< Back I Hest » I Cancel

Do not select Activate the default response rule.

Press the Next button to continue.

Completing the IP Security Policy Wizard



IP Security Policy Wizard ed A

- Completing the IP Security Policy
g Wizard
=

Y'ou have successfully completed specifuing the properties
for wour new [P Security palicy.

To edit your [P Security policy now, select the Edit properties
check baox, and then click Finish.

To cloge thiz wizard, click Finizh.

< Back I Firizh I Cancel

Select the Edit properties by default.

Press the Finish to continue.

Then the KernSafe IP Security Policy Properties dialog is shown.



Kernsafe IP Security Policy Properties 2| x|

Rules | General I

=pE]  Secuty rules for communicating with other computers

o Py

IF Security rules:

IF Filter List

4| | 1

gd. | Ede. | Femove | Useadd wisad

s I Cancel |

Do not select Use Add Wizard.

Press the Add button, the New Role Properties dialog is shown.



New Rule Properties ed 4

Authentication Methodz | Tunnel Setting I Connection Type
IF Filter List | Filter dction
E The zelected [P filter list specifies which netwark traffic will be
=, affected by thiz le.
I[P Filter Liztz:
M amne | D escription |
Al ICMP Traffic Matches all ICMP packets bebw...
O AP Traffic Matches all IP packets friom thiz ...
gd. | Ede. | Remoe |

(] I Cancel | Apply

Press the Add button, the IP Filter List dialog is shown.

Input IP Filter name.



- An P filker lizt iz compozed of mulkiple filkers. 1nthiz way, multiple subnets, [P
i: addrezzez and protocols can be combined into one [P filter.
Marme:
Femsafe
Dezcription: A
] Edit.. |
LI Bemowve |
IP Filters: [T Usze AddWizard
tirrared | D'escription | Praotocol | Source Port | D estination

1] | i

(] I Cancel |
Y

Type KernSafe in the Name and do not select Use Add Wizard.

Press the Add button to continue.



IP Filter Properties il |

Addresses | P'n:utl:u:l:nll Descriptiunl

—Source address:
I.-’-'-.n_l,l IP Address j

— Destination addrezs:

v Mimared. Match packets with the exact opposite zource and destination
addreszes.

s I Cancel

Select Any IP Address in the Source address.

Select My IP Address in the Destination address.

Then change to the Protocol page.



IP Filter Properties

Select TCP in Select a protocol type field.

Type 3260 in the To this port.

Press the OK button to continue.



An P filker lizt iz compozed of mulkiple filkers. 1nthiz way, multiple subnets, [P

—
i:: addrezzez and protocols can be combined into one [P filter.
Marme:
Femsafe
Dezcription: Add...
] Edi... |
LI Bemowe |
IF Filters: [ Use &ddWizard
tirrared | D'escription | Praotocol | Source Port | D estination
ires TCF AP a2h[

1] | i
k. I Cancel |

4

Press the OK button to continue.

New Rule Properties ed 4

Authentication Methodz | Tunnel Setting I Connection Type
IF Filter List | Filter dction
E The zelected [P filter list specifies which netwark traffic will be
=, affected by thiz le.
I[P Filter Liztz:
M amne | D escription |
2 Al ICMP Traffic Matzhes all ICMP packets betw.
O AP Traffic Matches all IP packets friom thiz ...
LOF K 25 afe
gd. | Edt. | Remove |

Cloze I LCancel | Apply




Select the KernSafe IP Filter item which we just created and change to Filter Action page.

New Rule Properties ed 4

Authentication Methodz I Tunnel Setting | Connection Type |
I Filter List Filter Action

The zelected filter action specifiez whether this rule negotiates
for secure nebwork traffic, and how it will secure the traffic.

Filter Actions:
M amne | D escription |
2 Pemit Permit unzecured IP packets ta .
) Request Secuity [Optional) Acceptz unsecured communicat. ..

Acceptz unsecured communicat. ..

LY R equire Security

Add... | Edit... | Bemove | W Use Add Wizard

Cloze I LCancel | Apply

Select Require Security and then change to Connection Type page.




Mew Rule Properties

Select the All network connections, and then change to Tunnel Setting page.



Mew Rule Properties

Select This rule does not specify an IPSec tunnel, and then change to Authentication Methods
page.



Mew Rule Properties

I Filter List | Filter A.ction
Authentication Methods I Tunnel Setting I Connection Type

|-

]

Authentication methods specify how trugt iz established

between computers. These authentication methods are

=l = offered and accepted when negotiating secunty with anather
computer.

Authentication method preference order:

b ethod | Details | Add..
kertberos ;

Edit..

Bemove

fmve up

e dawr

L

Cloze I LCancel Apply

Select Kerberos, press the Edit button, the Edit Authentication Method Properties dialog is

shown.



Edit Authentication Method Properties

Ame frarn Eh

ot mapping:

Select Use this string (preshared key) , type the preshared key, we take “123” as an example.



Mew Rule Properties

I Filter List | Filter A.ction
Authentication Methods I Tunnel Setting I Connection Type

=
[

Authentication methods specify how trugt iz established

between computers. These authentication methods are

=l = offered and accepted when negotiating secunty with anather
computer.

Authentication method preference order:

b ethiod D etailz Add...

Prezhared Key

Edit...

Bemove

fmve up

e dawr

LLF

Cloze I LCancel Apply

Press the Apply button to save settings and press the Close button to close this dialog.




Kernsafe IP Security Policy Properties 2| x|

Rules | General I

=pE]  Secuty rules for communicating with other computers

=

IF Security rules:

[t e NAEeetn At ] 1
.

O <Dynamic Default A esponge K.erberoz <M

4| | 1

Add.. Edit... | Bemove | ™ Use Add wizard

s I Cancel |

Check KernSafe in the IP Filter List and then press the OK button to continue.

Back to Local Security Settings main interface.



Flle Action  Wiew Help

Ii' Local Security Settings

=10 %]

«» | aE|XFR 2@ B34

@ Security Settings

-28 Accournt Policies

-8 Lacal Palicies

[:I Public Kev Policies

CI Software Restriction Policies

----- g IP Security Policies on Local Computer

Assign
All Tasks

Delete
Rename

Properties

Help

-

1P traffic, always req...
bnicate normally {uns... Mo
IP traffic, always req...  No

Last Modified Time

2009-7-9 1452123
2003-7-9 14:52:23
2009-7-9 14:52:23

Right click on the KernSafe IP Security Policy item and then select Assign to make this item

enabled.

3. Client Side Local Security Policy Setting

Open Start -> Control Panel -> Administrative Tools -> Local Security Policy, The Local Security

Settings Console is shown.




Flle Action  Wiew Help

Ii' Local Security Settings

=10 %]

= e E T

@ Security Settings

-28 Accournt Policies

-8 Lacal Palicies

[:I Public Kev Policies

; -[Z Software Restriction Policies

g IP Security Policies on Local Computer

Mame / | Descripkion

| Policy &... | Last Modified Time

e IP

Server (Request Sec,..  For all IP traffic, always req...
lient (Respond Onky)  Carmmunicate normally {uns. ..
Secure Server (Requi..  For all IP traffic, always req...

Manage IP filter lisks and filter actions, ..

Al Tasks

Refresh
Expork List...

=

Arrange Icons
Line up Icons

Help

2009-7-9 14:52:23
2003-7-9 14:52:23
2003-7-9 14:52:23

|Creates an IP Security policy,

IP Security Policies on Local Computer and right click on the blank of the right panel. Then select

Create IP Security Policy. The IP Security Policy Wizard is shown.

IP Security Policy Wizard

Welcome to the IP Security Policy

Wizard

Thiz wizard helpz you create an IP Security policy. ou waill
zpecify the level of zecurity bo uze when communicating with
gpecific computers or groups of computers [subnets], and for

particular 1P traffic types.

To continue, click Mest,

2l

< Back

Cancel |

Press the Next button to continue.




Enter IP Security Policy Name

IP Security Policy Wizard

IP Security Policy Hame
Mame thiz IF Secunty policy and provide a brief description

M arne:

k.ernSafe [P Secunty Policy

Dezcription:

< Back I Hest » I

Cancel

Type “KernSafe IP Security Policy”.

Press the Next button to continue.

Specify how this policy responds to requests for secure communication.




IP Security Policy Wizard ed A

Requests for Secure Communication 7
Specify how thiz policy responds to requests for secure communication.
-

The default rezponze rule responds to remote complters that request security, when no
ather rule applies. To communicate securely, the computer must respond to requests far
FECUNE communication,

[ ctivate the default responze rule. §

< Back I Hest » I Cancel

Don’t select the “Activate the default response rule”.

Press the Next button to continue.

Completing the IP Security Policy Wizard.

IP Security Policy Wizard ed A

Completing the IP Security Policy
Wizard

Y'ou have successfully completed specifuing the properties
for wour new [P Security palicy.

To edit your [P Security policy now, select the Edit properties
check baox, and then click Finish.

To cloge thiz wizard, click Finizh.

< Back I Firizh I Cancel




Select the Edit properties.

Press the Finish button to continue.

The KernSafe IP Security Policy Properties Dialog will be shown.
KernSafe IP Security Policy Properties 2| x|
Rules | General I

=pE]  Secuty rules for communicating with other computers

T

IF Security rules:

P Fiter List ) Filter Act
O% Dyramic 1efaulk

Authentication...

4| | 1

tgd. | Ede. |

Femaye | [ Use Add Wizard

s I Cancel |

Don’t select the Use Add Wizard option.

Press the Add button, the New Rule Properties dialog is shown.



Mew Rule Properties

Authentication Methodz |

Tunnel Setting I

2 x|

Connection Type

IF Filter List Filker &ction
E The zelected [P filter list specifies which netwark traffic will be
=, affected by thiz le.
I[P Filter Liztz:
M amne | D escription |
Al ICMP Traffic Matches all ICMP packets bebw...
O AP Traffic Matches all IP packets friom thiz ...
gd. | Ede. | Remoe |

o ]

Cancel |

Apply

Press the Add button to continue.

Setting IP Filter List.




- An P filker lizt iz compozed of mulkiple filkers. 1nthiz way, multiple subnets, [P
i: addrezzez and protocols can be combined into one [P filter.
Marme:
Femsafe
Dezcription: A
] Edit.. |
LI Bemowve |
IP Filters: [T Usze AddWizard
tirrared | D'escription | Praotocol | Source Port | D estination

1] | i

(] I Cancel |
Y

Type the name of IP filter.

Don’t select the Use Add Wizard option.

Press the Add button, the IP Filter Properties dialog is shown.



IP Filter Properties il |

Addresses | P'n:utl:u:l:nll Descriptiunl

—Source address:

— Destination addrezs:

&, gpecific |P Address j

IF"au:Iu:I[ess:I 192 . 168 . 0 . 8
Subriet mask: | 255 . 255 . 255 _ 25h

v Mimared. Match packets with the exact opposite zource and destination
addreszes.

s I Cancel

Select My IP Address in Source address Categories.

Select A specific IP Address in Destination address categories, and then type the IP address of
your server machine.
Select the Protocol page to continue.

Set protocol properties.



IP Filter Properties

Select TCP in the Select a protocol type categories, and then type 3260 in the To this port.
Press the OK button to continue.

Now we come back to the IP Filter List interface.



An P filker lizt iz compozed of mulkiple filkers. 1nthiz way, multiple subnets, [P

—
i:: addrezzez and protocols can be combined into one [P filter.
Marme:
Femsafe
Dezcription: Add...
] Edi... |
LI Bemowe |
IF Filters: [ Use &ddWizard
tirrared | D'escription | Praotocol | Source Port | D estination
ires TCF AP a2h[

1] | i
k. I Cancel |

Press the OK button to complete the IP Filter Item creation.

4

Authentication Methodz | Tunnel Setting I Connection Type
IP Filter List | Filter Action
E The zelected [P filter list specifies which netwark traffic will be
=, affected by thiz le.
I[P Filter Liztz:
M amne | D escription |
2 Al ICMP Traffic Matzhes all ICMP packets betw.
O AP Traffic Matches all IP packets friom thiz ...
LOF K 25 afe
gd. | Edt. | Remove |
Cloze I LCancel | Apply




Select the KernSafe IP Filter item we just create. Change to Filter Action page.

New Rule Properties ed 4

Authentication Methodz I Tunnel Setting | Connection Type |
I Filter List Filter Action

The zelected filter action specifiez whether this rule negotiates
for secure nebwork traffic, and how it will secure the traffic.

Filter Actions:

M amne | D escription |
2 Pemit Permit unzecured IP packets ta .
) Request Secuity [Optional) Acceptz unsecured communicat. ..

Acceptz unsecured communicat. ..

LY R equire Security

Add... | Edit... | Bemove | W Use Add Wizard

Cloze I LCancel | Apply

Select Require Security.
Change to Connection Type page.



Mew Rule Properties

Select All network connections.
Change to Tunnel Setting page.



Mew Rule Properties

Select This rule does not specify an IPSec tunnel.
Change to Authentication Methods page.



Mew Rule Properties

I Filter List | Filter A.ction
Authentication Methods I Tunnel Setting I Connection Type

=
[

Authentication methods specify how trugt iz established

between computers. These authentication methods are

=l = offered and accepted when negotiating secunty with anather
computer.

Authentication method preference order:

b ethod | Details | Add..
kertberos ;

Edit..

Bemove

fmve up

e dawr

L

Cloze I LCancel Apply

Select Kerberos.
Press the Edit button, the Edit Authentication Method Properties dialog is shown.



Edit Authentication Method Properties 2| x|

Authentication kMethod |

The authentication method specifies how trust iz established
= = between the computers.

[
[

" Active Directory default [Kerberos W5 protocol]

" Use a certificate from this certification authaority [CA]:

I Browze, . |

[T | Exclude the C& name fram the certificate request

" | Enable certifizate to azzount mapping

% Use this string [preshared key]:

123 =

=
k. I Cancel |

Select Use this string (preshared key), then type 123 or other text as password in the input box.

Press the OK button to apply.



Mew Rule Properties

I Filter List | Filter A.ction
Authentication Methods I Tunnel Setting I Connection Type

=
[

Authentication methods specify how trugt iz established

between computers. These authentication methods are

=l = offered and accepted when negotiating secunty with anather
computer.

Authentication method preference order:

b ethiod D etailz Add...

Prezhared Key

Edit...

Bemove

fmve up

e dawr

LLF

Cloze I LCancel Apply

Press the Apply button and then press the Close button to close this dialog.




Kernsafe IP Security Policy Properties 2| x|

Rules | General I

=pE]  Secuty rules for communicating with other computers

=

IF Security rules:

[t e NAEeetn At ] 1
.

O <Dynamic Default A esponge K.erberoz <M

4| | 1

Add.. Edit... | Bemove | ™ Use Add wizard

s I Cancel |

Select KernSafe IP Filter item and then press the OK button.

Back to the Local Security Settings Console main interface



Flle Action  Wiew Help

Ii' Local Security Settings

=10 %]

«» | aE|XFR 2@ B34

@ Security Settings

-28 Accournt Policies

-8 Lacal Palicies

[:I Public Kev Policies

CI Software Restriction Policies

----- g IP Security Policies on Local Computer

Assign
All Tasks

Delete
Rename

Properties

Help

-

1P traffic, always req...
bnicate normally {uns... Mo
IP traffic, always req...  No

Last Modified Time

2009-7-9 1452123
2003-7-9 14:52:23
2009-7-9 14:52:23

Select IP Security Polices on Local Computer and then right click on the blank of right panel.

Select the Assigh menu item in the popup menu to make this item enabled.

4. Logging on to the target

Open Microsoft Initiator




x
General Discovery | Targetsl Perziztent Targetsl B ound Vulumestevicesl
— Target Portals
Addrezs | Puart | Adapter | IF .-’-'-.ddressl
Add | | Bemove I Refresh |
—I5MS Servers
M ame |
Add Hemove | Refrezh |
(] | Cancel | Spply |

Select the Discovery tab page.

Press the Add button in the Target Portals, the Add Target Portal dialog is shown.

Add Target Portal x|

Type the IP address or DMS name and socket number of the portal you
want ko add, Click Advanced ko select specific settings For the discovery
session ko the porkal,

IP address or DMS name: Fort:

192.168.0.5 |325|:| Advanced... |
K I Cancel |

Type the IP address and port of your server.

Press the OK button to continue.



i9C5I Initiator Properties

General Discovery | T argets I Perziztent Targetz I Bound Wolumes/Devices I

— Target Portals

ddress

IF Addresz

X

Add Bemove Refrezh |
—I5MS Servers
M ame |
Add Hemove Refrezh |
(] I Cancel | Spply |

Change to Targets page.



iSCSI Initiator Properties ﬂ

Eeneral I Discovery T argets | Perziztent Targetz I Bound Wolumes/Devices I

Select a target and click Log On to accezs the storage dewvices for that
target. Click detailz to zee information about the seszionz, connections and
devices for that target.

Targets:

M ame | Status |
ign. 2006-03. com. kernzafe. kernzate-test. Image...  Inactive

Detailz | Log On... |

1[4 | Cancel | Spply

Select the target in the Targets list, and then press the Log On button.

Then the Log On to Target dialog is shown.

Log On to Target x|

Target name:

[ Automatically restore this connection when the system boots

™ Enable mulki-path

L\'. Only seleck this opkion if i5C5I multi-path software is already installed
= gn your computer,

advanced. ., | | Ik I Zancel

If your iSCSI target using IP filter authorization, just press the OK button to continue.

If your iSCSI target using CHAP user authorization, press the Advance button, the Advanced
Settings dialog is shown.



Advanced Settings il |

General I IPSec I

— Connect by uzing
Local adapter: IDEfauIt j
Source |P: I Default j
Target Partal: IDEfauIt j
—CRC ¢ Checksum
[T Data digest [~ Header digest

¥ CH&P logon information

CHAP helps enzure data securnity by providing authentication bebween
a target and an initiator trying to establizh a connection. To use it
zpecify the zame target CHAP secret that was configured an the target
for thiz initiator,

Uzer name: It'E!St

Target§ecret: I'."'."'."l

[ Perform mutual authentication

To uge mutual CHAF zpecify an initiatar secret on the [nitiatar Settings
page and configure that secret on the target.

(] 4 I Cancel Smply

Select CHAP login information and type User name and Target secret.

Press the OK button to continue.



i9C5I Initiator Properties

Eeneral I Discovery T argets | Perziztent Targetz I Bound Wolumes/Devices I

Select a target and click Log On to accezs the storage dewvices for that
target. Click detailz to zee information about the seszionz, connections and
devices for that target.

Targets:
M ame | Status
ign. 2006-03. com. kermnzafe kermzafe-test. Image...  Connected

|

Refresh |

Detailz |

X

1[4 | Cancel | Spply

When the connection is created, you will see the connection in the Status column.

Now, you may operation the iSCSI disk just as a normal disk.

5. Effect

TCP/IP online traffic when not using IP SEC.

Fi_Iter:I ¥  Expression... Clear Apply

| Source | Destination Protocal Info

197.1658.15%.142 197.1658.159.131 isCs1 SCsI: Mode sense(6) LUM: Ox00
197.168.15%.142 197.168.159.131 isCsI SCSI: Read Capacity(lo) LUM: Oxi
192.168.155.142 192.168.155.131 J5C5I SCSI: Read(l0) LUN: Ox00 (LBA: O
192.168,159.142 1%92.168.159,131 1SCSI SCSI: Read(l0) LUW: 0Ox00 (LBA: O
1592.168,159.142 152.168.155%,131 1SCSI SCEI: Read Capacity(l0) LUN: Oxi
152.168,159,.142 152.168.159,131 1SCST SCSI: Read(l0) LUW: Ox00 (LBA: O
192.168.159.142 152.168.15%.131 JSCST SCSI: Read(lo) LUM: 0x00 (LBA: O
192.1658.15%.142 197.1658.152.131 i=Cs1 SCSI: Read Capacity (10D LUNM: Oxi

We will “see” all the information when initiators communication with targets.

TCP/IP online traffic when using IP SEC.



Filker: I j Expression... Clear  Apply

| Source Destination | Protocol |InFn

IT9:. 108, L9, L1 T92. 106, Lad. IS ESF ESF (SFI=URSBIT3L70)]
152.168.155.131 1592.168.1535,142 ESP ESP (SPI=0x83Ff2c70)
192.168.15%.131 192.168.155.142 ESP ESP (SPI=0xBETT3c70)
152.168.15%9.131 192.168.1559,142 ESP ESP (SPI=0xB8TT3c70)
152.168.15%.131 152.168.1535,142 ESP ESP (SPI=0xBBTT3<70)
1592.168.15%.142 192.168.1559.131 ESP ESP (SPI=0x572fdafa)
152.168.15%.142 1592.1658.1535,131 ESP ESP (SPI=0x572fdafs)
1592.168.15%.142 192.168.1559.131 ESP ESP (SPI=0x572fdafa)
152.168.15%9.142 1592.168.155,131 ESP ESP (SPI=0x572fdafs)
1%2.168.15%.151 192.168.155.142 ESP ESP (SPI=0xB8TT3c70)
152.168.15%9.131 192.168.1559,142 ESP ESP (SPI=0xB8TT3c70)
152.168.15%.131 152.168.1535,142 ESP ESP (SPI=0xBBTT3<70)
1%92.168.15%.131 192.168.1559.142 ESP ESP (SPI=0x88TF3c70)
152.168.15%.131 152.168.1535,142 ESP ESP (SPI=0xB8BTT3<70)
15%2.168.15%.131 1592.1658.155.142 ESP ESP (SPI=0xB8TT3c70)
152.168.155.131 1592.168.1535,142 ESP ESP (SPI=0x83Ff2c70)
15%2.168.15%.142 192.168.155.131 ESP ESP (SPI=0x572fdafa)

4

All the information is encrypted.
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